
A. Tick ( ) the correct option.
 1. (a) 2. (a) 3. (a)
B. Write  for True and  for False statements.‘T’ ‘F’
 1. F 2. F 3. T
C. Fill in the blanks.
 1. fast    2. time
 3. electricity   4.  mistakes
D.  Answer in one word.
 1. Human 2. Computer
 3. Clock, Remote Control 4. Computer
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What is a Computer?1
C H A P T E R

1. Yes, sharpener is a machine because it makes our work easier and helps us to 
save time.

2. No, all human-made things are not machine.
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B. Do yourself.



A. Tick ( ) the correct option.

 1. (a) 2. (b) 3. (b)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. F 2. F 3. T

C. Fill in the blanks.

 1. draw 2. store   3. solve

D.  Answer in one word.

 1. Movies 2. Computer  3. Hospitals

Uses of a Smart Machine2
C H A P T E R

Do Yourself.

A. 1. B A N K

 2. S C H O O L

 3. H O S P I T A L

 4. O F F I C E

B. See pictures in the book.

    skate

C. Do yourself.

A. Tick ( ) the correct option.

 1. (a) 2. (a) 3. (a)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. T 2. F 3. F

Components of Computer3
C H A P T E R

2



C. Fill in the blanks.
 1. brain   2. monitor
 3. mouse   4.  keyboard
D.  Answer in one word.
 1. Four, CPU, Monitor, Keyboard and Mouse
 2. Central Processing Unit
 3. Speakers 4. Keyboard

1. Speakers  2. Hard Disk 

A. 

M  N  T  R __ __ __ M U  E __ __K Y  O  R __  __ __ __ C U B X__ __O I O P O E B A D O S

B. 1. Mouse   2. Monitor

 3. Keyboard   4.  CPU

C. Do yourself.

A. Tick ( ) the correct option.

 1. (a) 2. (a) 3. (a)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. F 2. F 3. T

C. Fill in the blanks.

 1. spacebar 2. longest  3. 10

D.  Answer in one word.

 1. Spacebar key 2. Number keys 3. 26

Keyboard4
C H A P T E R

1. Number keys  2. Enter key

3



A. Output     Keys used

 VIKAS     Alphabet Keys

 698755     Number Keys

 Office 56    Alphanumeric Keys

B. 

Caps Lock Space bar

Backspace
Delete key

Number keys

A.

Computation Thinking

B. AEROOPLANE BUISCCUIT TIAGER

COMPPUTER KEYBOOARD GAMMEES

AEROPLANE BUISCUIT TIGER

GAMESKEYBOARDCOMPUTER

C. A S E T C P U R B V N I K Y L

P E T L I S T E N K E Y

P R I N TE N T E R
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A. Tick ( ) the correct option.

 1. (a) 2. (a) 3. (b)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. T 2. F 3. T

C. Fill in the blanks.
 1. tail    2. scroll
 3. click   4.  draw

D.  Answer in one word.

 1. Two 2. CPU   3. Index

Mouse5
C H A P T E R

Double click the left mouse button.
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A. Tick ( ) the correct option.

 1. (a) 2. (b) 3. (b)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. F 2. T 3. F 4. T

C. Fill in the blanks.

 1. drawing 2. toolbar  3. drawing canvas

 4.  help area 5. Eraser

D. Match the following:

 Functions       Tool

 1. To insert a ready-made drawing

 2. To colour a ready-made drawing

 3. To erase a drawing

 4. To save a drawing

 5. To close the Tux Paint

E.  Answer the following questions.

 1. To make any drawing on a computer, we have TUX Paint program that 
helps us to make colourful drawings.

 2. Toolbox, colors palette.

 3. Fill tool is used to fill colour inside the picture.

 4. We use the Eraser tool to type erase our drawing.

 5. Saving the drawing helps you to see it later.

Tux Paint6
C H A P T E R

She can use Tux Paint. She can download it from https://tuxpaint.org.

Toolbox

Colors Palette

Drawing Canvas

Selector Pane

A. B.   Do yourself.
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A. Tick ( ) the correct option.

 1. (b) 2. (b) 3. (b)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. T 2. T 3. F

C. Fill in the blanks.

 1. Chatbot 2. Machines  3. Gaming

D.  Answer the following questions.

 1. Machine takes some decisions based on their intelligence. This 
intelligence is called artificial intelligence.

 2. All we have an intelligence from which we take decisions. We called it 
human intelligence.

 3. (a) A robot is used in logistic factories to carry the goods.

  (b) A robot is used in car factories to manufacturing.

Fun with AI7
C H A P T E R

Use www.google.com on internet and search the topic by typing 'Robo-My 
friend'. Open relevant link to explore more information.

A.

YES NO YES NO YES NO

B.
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A. Tick ( ) the correct option.
 1. (c) 2. (a) 3. (a) 4. (a)
B. Write  for True and  for False statements.‘T’ ‘F’
 1. F 2. F 3. T 4. T
C. Fill in the blanks.
 1. data 2. pencil box  3. storage
D.  Answer in one word.
 1. Almirah
 2. School Bag
 3. Hard disk
 4. Any word, number, picture, sound or video which we feed in computer.
E.  Match the following.

 Hard disk

 CD/DVD

 Pen Drive

F.  Unscramble the given words.

Storage in a Computer8
C H A P T E R
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1. Pen Drive  2. Hard Disk

A.

B.   Do yourself. C.   Do yourself.
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A. Tick ( ) the correct option.

 1. (c) 2. (c) 3. (b)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. T 2. F 3. F 4. T

C. Fill in the blanks.

 1. decision   2. car

 3. speed   4.  desktop

D.  Answer the following questions.

 1. A man has brain. He can take decisions on its own but a computer cannot 
take decisions itself.

 2. A computer cannot take decisions itself. It needs instructions from a 
human to work.

 3. Desktop, Laptop, Tablet.

 4. Computers are useful to teachers in following ways:

  (a) Keeping records of students and teachers.

  (b) Making worksheets, timetable and report cards.

  (c) Keeping records of books in Library.

Computer : A Smart Machine1
C H A P T E R

TECH TOUCH 2

Laptop

A.  1. C  2. M   3. C

 4. C  5. M

B. 
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A. Tick ( ) the correct option.

 1. (b) 2. (b) 3. (b)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. F 2. T 3. T 4. T

C. Fill in the blanks.

 1. output 2. processes  3. Charles Babbage

 4. electronic 5. processing

D. Match the given columns properly.

 1. Computer     (a) CPU

 2. Input     (b) IPO Cycle

 3. Output     (c) Monitor

 4. Processing     (d) Keyboard

E.  Answer the following questions.

 1. Input – Process – Output

 2. A computer works in three steps:

  This is called the IPO Cycle.

 3. Keyboard

 4. CPU

Working of a Computer2
C H A P T E R

Input Process Output

Input : 5, 7, + Process : Addition  Output : 12

10



INPUT PROCESS OUTPUT

Dirty clothes Washing machine Clean clothes

Food Refrigerator Fresh food

Cloth Sewing machine Shirt

I N P U T

P R O C E S S

O U T P U T

I P O C Y C L E

A. Tick ( ) the correct option.

 1. (b) 2. (monitor) 3. (a)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. F 2. T 3. F 4. T

C. Fill in the blanks.
 1. mouse   2. Storage
 3. Output   4.  keyboard

D.  Answer the following questions.

 1. A computer has four main parts:

  (a) Monitor (b) Keyboard

  (c) Mouse (d) CPU box

 2. Keyboard

 3. Monitor is an output device that looks like a television. It shows us 
whatever we type on the computer.

 4. Printer is used to print the output on the paper. These printed papers are 
known as hard copy.

Parts of a Computer3
C H A P T E R

Monitor

11
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Lab Activity 
        Do yourself.

A. Tick ( ) the correct option.

 1. (c) 2. (a) 3. (a)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. T 2. T 3. T 4. F

C. Fill in the blanks.
 1. Spacebar   2. toggle
 3. four   4.  delete

D.  Answer the following questions.

 1. Spacebar key is used to give space between two words.

 2. Enter key is used to move the cursor to the next line.

 3. Caps Lock key is used to type the capital letters. For example, when Caps 
Lock is enabled, the typed letters appears "LIKE THIS". When disabled, 
they appear "like this".

The Typing Device4
C H A P T E R

1. Alphabet Keys
2. Backspace key or Delete key

12



A. Do yourself.

B. (a) A

 (b) &

C. Backspace key

Number keyArrow keysShift keySpacebar keyCaps Lock key

A. Tick ( ) the correct option.

 1. (a) 2. (a) 3. (c)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. F/T 2. F 3. T 4. T

C. Fill in the blanks.
 1. scroll-wheel   2. arrow
 3. Double   4.  Dragging

D.  Answer the following questions.

 1. Optical mouse, wireless mouse.

 2. Pressing the left mouse button once is called single click.

 3. It will show a list of menu options.

 4. Moving an object to a new place is known as dragging.

The Clicking Device5
C H A P T E R

Wireless Mouse

13



A. 

Single-click Double-click Right-click

B. 

C. Do yourself.

?

A. Tick ( ) the correct option.
 1. (a) 2. (a) 3. (a)

B. Write  for True and  for False statements.‘T’ ‘F’
 1. F 2. T 3. T

C. Fill in the blanks.
 1. icons   2. Power
 3. booting   4.  shutdown

D.  Answer the following questions.
 1. Start button.
 2. The desktop has many small pictures with names. These are called Icons.
 3. Desktop.
 4. Start button.

Operating a Computer6
C H A P T E R

Doing so can lead to data loss or corruption and potentially cause an electrical 
short, leading to a power spike.
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 (ii) 

A. Tick ( ) the correct option.

 1. (b) 2. (c) 3. (b) 4. (c)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. F 2. T 3. T 4. T

C. Fill in the blanks.
 1. Shapes   2. line
 3. colours   4. help area

More on Tux Paint7
C H A P T E R
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D. Identify the picture portion and match it with the tool.
 

E.  Answer the following questions.

 1. Toolbar, Selector pane, Drawing canvas, colors pallete, Help area.

 2. The Text tool is used to type text on the drawing area.

 3. Line tool.

 4. Star, Triangle, Square, Polygon.

A. 

Paint Tool

Toolbar Selector Pane

Drawing Canvas

Colors Pallete

Help Area

B.    C. Do yourself.
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A. Tick ( ) the correct option.

 1. (c) 2. (a) 3. (b) 4. (b)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. F 2. F 3. T 4. F

C. Fill in the blanks.
 1. Paint   2. Title bar
 3. Fill with color   4.  Home

D. Rearrange the jumbled words to make meaningful words.

 (a)     (b) 

 (c)     (d) 

E.  Answer the following questions.

 1. Fill with Color Tool. 2. Eraser Tool.

 3. Pencil Tool. 4. Colors group.

Let us Draw in Paint8
C H A P T E R
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Eraser Tool

A.     B.  Do yourself.
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A. Tick ( ) the correct option.

 1. (c) 2. (a) 3. (b) 4. (b)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. T 2. F 3. F 4. T

C. Fill in the blanks.
 1. smart   2. easier
 3. face   4.  amazon

D.  Answer the following questions.

 1. Artificial Intelligence (AI) is the ability of a computer or a machine to 
think, learn and act like human brain. The goal of Artificial Intelligence is 
to develop computers that are smart and can take decisions themselves 
to solve any problem.

 2. Voice assistant, Robots.

 3. Chatbot ELIZA.

 4. Robots are automatically operated machine that work in place of 
humans.

E.  Rearrange the letters to get meaningful words.

 1. 

 2. 

 3. 

 4. 

 5. 

Artificial Intelligence Around Us9
C H A P T E R

B O T

S I IR

C O R T A N A

G O O G L E

A L E X A

R O 

1. In today's time, AI is considered a bane because it will eat up many jobs and 
become a major replacement for human beings. However, AI can also be 
considered a boon because it can perform multiple tasks effectively and 
produce faster results than humans.

 Yes, AI becoming an indispensable part of our lives. For example, it's 
impossible for human being to survive in space for such a long time if there is 
no AI-powered robot.

2. Domains of AI are machine learning, deep learning, natural language 
processing, computer vision, and data science.

 Search these topics on internet and choose your favourite AI domain.

18



A. 1. CCTV surveillance

 2. GPS tracker

 3. Biometric attendance

 4. Digital content

 5. Virtual class

B. Apple's Siri, Google Now, Amazon's Alexa, Microsoft's Cortana, IBM Watson, 
Infosys Nia, Google Assistant, ELSA Speak, Data Bot, Hound.

C. 

Self driving CarEcho Dot Robot

19



A. Tick ( ) the correct option.

 1. (c) 2. (c) 3. (c) 4. (b) 5. (a)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. F 2. T 3. T 4. F 5. T

C. Fill in the blanks.

 1. Hardware, Software  2. CPU  3. Output

 4. Application  5. Operating System

D. Match the following.

 1. Input device    (a) Printer

 2. Output device    (b) Scanner

 3. Storage device    (c) Operating System

 4. Processing unit    (d) CD

 5. Software    (e) CPU

E.  Answer the following questions.

 1. All the physical parts of a computer that you can see and touch are called 
hardware. For example: keyboard, mouse and CPU.

  A Computer is an electronic machine. It cannot work by itself. A computer 
needs instruction (set of programs) to do anything. These step-wise 
instructions are called Software.

 2. The devices that are used to enter data into the computer are called input 
devices. The most commonly used Input devices are keyboard, mouse, 
scanner, etc.

  Output devices are used to display the result of the processed data and 
instructions. The most commonly used output devices are monitor, 
printer and speakers.

 3. CPU controls and processes the information that we enter.

 4. Hard Disk, Compact Disk (CD), Pen Drive

 5. When you start your computer, a software also starts with it. This 
software is called the operating system.

A Computer System1
C H A P T E R

TECH TOUCH 3

1. Microphone  2. Application software

20



A. Types of Software

A P P L I C A T I O N

S O F T W A R E

S Y S T E M

S O F T W A R E

O P E R A T I N G

S Y S T E M

C A L C U L A T O R

P A I N T

B. Do yourself.

A. Tick ( ) the correct option.

 1. (a) 2. (a) 3. (a) 4. (a)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. F 2. T 3. T 4. F 5. T

C. Fill in the blanks.

 1. Microsoft  2. Desktop 3. Icons

 4. Double  5. Wallpaper

D. Match the following.

 1. Maximize button

 2. Close button

 3. Minimize button

 4. Restore button

Introduction to Windows 102
C H A P T E R
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E.  Answer the following questions.

 1. Ctrl key.

 2. Start button, Task View button, Quick Launch Bar, Notification Area and 
Show Desktop button.

 3. Task View allows a user to quickly locate an open window, quickly hide all 
windows and show the desktop, and to manage windows across multiple 
monitors or virtual desktop.

 4. (a) When we switch on the computer, the operating system gets loaded 
into the computer's memory. This process is called booting.

   After booting, you get the welcome and login screens, then the main 
screen of the Windows appears, known as the Desktop. Desktop is 
the first screen that appears when you turn on the computer.

  (b) Operating system is a software that manages and controls the 
different parts of a computer system and other software. Microsoft 
Windows is the most commonly used operating system. It acts as an 
interface between the user and the computer system.

 5. On the left side of the Taskbar is the Start button. Clicking on the Start 
button opens the Start Menu. Start menu has two panes. The Left pane 
displays a list of programs called apps whereas the right pane has 
application icons in the form of tiles.

Seema should use Task View button.
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B. 1. 

 2. 

 3. 

 4. 

 5. 

T A S K B A R

D E S K T O P

W A L L P A P E R

I C O N S

C L O S E

C. 1. YYYIYYCYYYOYNYYYS  I C O N S

 2. YYSYYTYAYYRYT BYYUYTTYYYOYN  S T A R T  B U T T O N

 3. YYYYTYAYYYSYYKYYYBYAYYRY  T A S K  B A R

 4. YYYDYEYYYSYYYKYTYOYYYYPY  D E S K T O P

D. Do yourself.

A. Tick ( ) the correct option.

 1. (a 2. (b) 3. (a) 4. (b) 5. (c)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. T 2. F 3. T 4. F 5. T

C. Fill in the blanks.

 1. Magnifier  2. Copy & Paste 3. Text

 4. Selection  5. Flip

D. Match the following.

 1.     (a) Select

 2.     (b) Text

 3.     (c) Eraser

 4.     (d) Pencil

 5.     (e) Color Picker

 6.     (f) Fill Color

E.  Answer the following questions.

 1. Rectangular Selection Tool and Free-form Selection Tool.

More About MS Paint3
C H A P T E R
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 2. The Text Tool allows us to add text or messages to our drawings.

 3. The foreground controls what color your brush or pencil will be, while the 
background color erases any added color and replaces it with the 
background color, which is white by default.

 4. Cut option helps us to cut the selected part of a drawing and move (paste) 
it to a new location while copy option helps us to make a copy of the 
selected part.

1. One-time

2. The steps to rotate the picture are as follows:

 Step 1 : Click on the Select tool and select the picture.

 Step 2 : Click on the Rotate option in the Image group on the Home tab.

   A list of options will be displayed for changing the rotation or flipping.

 Step 3 : Select the desired option.
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C. Do yourself.
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A. Tick ( ) the correct option.

 1. (b) 2. (b) 3. (b) 4. (a) 5. (b)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. F 2. T 3. T 4. T 5. F

C. Fill in the blanks.

 1. .docx  2. Title bar 3. File

 4. horizontal scrollbar  5. close

D. Match the following.

 1. Ctrl + N  2. Ctrl + O

 3. Ctrl + S  4. Alt + F4

E.  Answer the following questions.

 1. Microsoft Word, OpenOffice.

 2. Title bar, Quick Access Toolbar, Ribbon, Scroll Bars, Ruler

 3. Word Wrap is a word processing feature that automatically transfers a 
word for which there is insufficient space from the end of one line of text 
to the beginning of the next.

 4. To create a new document, follow the given steps.

  Step 1 : Click on the File tab. The backstage view appears.

  Step 2 : Click on the New option from the left pane.

  Step 3 : Select the Blank document in the right pane.

  A blank new document opens in a new Word window.

Introduction to MS Word 20164
C H A P T E R

To save the document, follow the steps given below :

Step 1 : Click on the File tab. The backstage view appears.

Step 2 :  Click on the Save As option.

Step 3 :  Select the location where you want to save the file.

   The Save As dialog box appears.

Step 4 :  Enter the name of the file in the File name box.

Step 5 :  Click on the Save button. The document will be saved with the name and 
location chosen by you.
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C. Do yourself.

A. Tick ( ) the correct option.

 1. (a) 2. (a) 3. (b) 4. (a) 5. (a)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. F 2. T 3. F 4. F 5. F

C. Fill in the blanks.

 1. clipboard  2. Ctrl + B 3. Undo

 4. Italic  5. Copy

D. Write the functions of given shortcuts:

 1. Undo  2. Select All

 3. Bold  4. Open

E.  Answer the following questions.

 1. To insert the text at any place in between an already typed text follow the 
steps given below.

  Step 1 : Position the cursor to the right of the character where you want 
to insert the text.

Editing in MS Word 20165
C H A P T E R
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  Step 2 : Type out of the required text. As you type the text, the existing 
text shifts to the right.

 2. 

 3. Copying the text means the selected text will remain at its original 
position as well as the place where it is pasted.

  Moving the text means to cut a piece of text from one location and paste 
it at another location.

 4. The Undo option, is used for reversing the last action we performed in MS 
word. The Redo option, on the other hand, helps us to repeat the action 
we have undone using the Undo option.

Using Mouse

Selection Method

A word Double-click on the word.

A sentence
Hold down the Ctrl key and click anywhere on the 
sentence.

A paragraph Triple-click within the paragraph.

A. Human being have lived on Earth for many century . They have learnt to grow 
Crop for their food. They have used the Earth's natural resource, such as river, 
forests and mineral. They have learnt how to make and use tool to protect 
themselves and build shelter. They have built large city to live and work in. 
They have also built road to travel from one place to another and bridge to 
cross large rivers.

B. Do yourself.

A. Tick ( ) the correct option.

 1. (a) 2. (b) 3. (a) 4. (c) 5. (b)

Introduction to Scratch6
C H A P T E R

Place the cursor before the first letter of the sentence or word. Hold down Shift key 

000000 000 and press the right arrow key  to select the desired portion of the text.  

Press Ctrl + A to select the entire document.
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B. Write  for True and  for False statements.‘T’ ‘F’

 1. F 2. F 3. T 4. F 5. T

C. Fill in the blanks.

 1. kids  2. scripts  3. block palette

 4. white  5. Motion

D. Unscramble the jumbled words.

 1. 

 2. 

 3. 

 4. 

 5. 

E.  Answer the following questions.

 1. Scratch is an educational programming language designed for kids that 
makes it easy to program your own interactive stories, animations, 
games, music and art. In the process, they learn to solve problems, 
design projects and express themselves creatively on the computer.

 2. Using scratch children can easily create attractive shapes, animated 
stories, computer games, music and art.

 3. A backdrop is the background of the stage.

 4. (a) Sprite is the actor who acts on the stage. Sprite is an object in Scratch 
that perform the function on Stage area. The default sprite in Scratch 
is an orange cat.

  (b) The script is a block or a set of blocks which forms a code or a 
program.

 5. The turn left ( ) degrees block will make a sprite move in anticlockwise 
direction.
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1. Use Motion Block.

2. You can make a character move backwards by giving your motion blocks 
negative numbers.

A. Do yourself.
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A. Tick ( ) the correct option.
 1. (c) 2. (b) 3. (b) 4. (a) 5. (b)

B. Write  for True and  for False statements.‘T’ ‘F’
 1. T 2. T 3. F 4. T 5. T

C. Fill in the blanks.
 1. Internet  2. Modem 3. Web
 4. Google  5. WWW

D. Write the fullform of following:
 1. WWW : World Wide Web
 2. URL : Uniform Resource Locator
 3. ISP : Internet Service Provider

E.  Answer the following questions.

 1. The Internet is a network of the interlinked computer networking 
worldwide. This network is accessible to the general public. Internet is 
such a huge network of several different interlinked networks relating to 
the business, academics and many smaller domestic networks. Hence, it 
is known as the network of all the other networks.

 2. Microsoft Edge, Mozilla Firefox.

 3. Webpage is the part of a website. Website is like a book and webpage is 
like a page of that book. A web page is a digital page containing 
information in the form of text, pictures, video and sound.

 4. Internet is very useful for everyone. Some of its uses are discussed below:

  (a) Internet is used to download songs and movies.

  (b) Internet is used to see the latest news. 

  (c) Internet helps to search information.

Internet7
C H A P T E R

Microsoft Edge, Google Chrome.

A.

Google Chrome Microsoft Edge Mozilla Firefox Opera Safari
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B. (a) Library  (i) Websites

 (b) Books  (ii) Web pages

 (c) Book pages (iii) Internet

C. Do yourself.

A. Tick ( ) the correct option.

 1. (a) 2. (b) 3. (c) 4. (b) 5. (c)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. T 2. T 3. T 4. T 5. F

C. Fill in the blanks.

 1. Artificial Intelligence  2. Smart Speaker 3. Smart Assistant

 4. Chatbot  5. Smart phones

D. Unscramble the jumbled words.

 1. 

 2. 

 3. 

 4. 

 5. 

E.  Answer the following questions.

 1. Smart watch, Smart doorbell, Smart TV, Self-Driving cars.

 2. Chatbot.

 3. In driverless car, AI software in the car is connected to all the sensors and 
collects input from street view and video cameras inside the car. The AI 
simulates human perceptual and decision-making processes using deep 
learning and controls actions in driver control systems, such as steering 
and brakes.

 4. Google Map shows you directions and uses real-time traffic information to 
find the best route to your destination. With voice navigation, you can hear 
traffic alerts, where to turn, which lane to use, and if there's a better route.

 5. Voice assistant carries out everyday tasks via voice command. It is brings AI 
and machine learning together to recognize our voice and do what we ask it.

AI-Enabled Devices8
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Before setup, download or update the Alexa app in your mobile device app store.

1. Plug in you device.

2. Open the Alexa app.

3. Open More and select Add Device.

4. Select Amazon Echo.

5. Follow the instructions to set up your device.

6. Get started, just ask Alexa.
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B. Do yourself.
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A. Tick ( ) the correct option.

 1. (c) 2. (a) 3. (c) 4. (a) 5. (c)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. F 2. F 3. T 4. F 5. T

C. Fill in the blanks.

 1. Output device  2. scanner 3. CPU

 4. Webcams  5. barcode scanner

D. Guess who am I?

 1. Microphone  2. Printer 3. RAM

 4. Headphone  5. Scanner

E.  Answer the following questions.

 1. (a) (i)  Keyboard (ii) Mouse

  (b) (i)  Monitor (ii) Printer

 2. CPU is considered as the brain of the computer. CPU performs all types of 

data processing operations. It stores data, intermediate results, and 

instructions. The CPU is a chip inside the CPU box, mounted on the 

motherboard along with other components. It has three main parts: 

Arithmetic Logic Unit (ALU), Control Unit (CU), Memory Unit (MU).

 3. IPO stands for input processing output. Computer takes input, process on 

it and gives output.

 4. A monitor, also known as the Visual Display Unit (VDU) is the main output 

device of the computer because the output that we get on a monitor is 

called soft copy.

 5. A printer helps to print the output on paper in the form of text and 

pictures. The printed copy is called the Hard Copy. Printer come in 

different types:

  (a) Dot Matrix Printer (b) Inkjet Printer

  (c) Laser Printer

Introduction to Computers1
C H A P T E R

TECH TOUCH 4

32



1. Vikrant should use Inkjet printer because this printer is better for printing color 
documents. Sachin should use laser printer because this printer is much faster 
than inkjet printer and better suited for printing text-based documents.

2. Scanner
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B. Calculation is being done 

 Dirty water

C. Do yourself.

A. Tick ( ) the correct option.

 1. (a) 2. (b) 3. (c) 4. (c) 5. (a)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. T 2. T 3. T 4. T 5. T

C. Fill in the blanks.

 1. RAM, ROM  2. pen drive 3. auxiliary

 4. bit   5. Memory card

Memory and Storage2
C H A P T E R
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D. Write the full form of the following abbreviations.

 1. Read Only Memory   

 2. Universal Serial Bus

 3. Random Access Memory

 4. Compact Disc

 5. Digital Versatile Disc

E.  Answer the following questions.

 1. Any physical device capable of storing information temporarily or 
permanently can be considered as computer's memory. Most modern 
personal computers have two types of memory– Internal Memory, also 
known as the Primary or Main memory and External Memory, also 
known as the Secondary memory or Auxiliary memory.

 2. A computer can understand only two states – ON (represented by 1) and 
OFF (represented by 0). Data in the computer's memory is represented by 
these two digits 0 and 1. These two digits are called Binary Digits or Bits. It is 
the smallest unit of computer's memory. The amount of data and 
instructions that can be stored in computer memory is measured in Bytes.

  To represent each character in memory, a set of 8 binary digits is used. 
This set of 8 bits is called a Byte.

 3. (a) A device covered with a magnetic coating is called a Magnetic disk.

  (b) The Flash Drive is a small portable data storage device integrated 
with a USB (Universal Serial Bus) connector.

  (c) An optical disc is an electronic data storage medium that can be used 
to write and read using a low powered laser beam.

 4. Blu-Ray is an Optical disc storage device used to store a large amount of 
data or high definition of video recording and playing other media files. It 
uses laser technology to read the stored data. The Blu-ray Disk can store 
more data at a greater density as compared to CD/DVD. Blu-ray Discs 
provide 28 GB of space to store data.

 5.

1. CD, DVD

34

1. RAM stands for Random Access 
Memory.

1. ROM stands for Read Only Memory.

2. Temporary storage. 2. Permanent storage.

3. It is volatile in nature. Its contents 
are erased whtn power is turned off.

3. It is non-volatile in nature. Its 
contents are non-erased when 
power is turned off.

RAM ROM



2. Use a soft cloth to clean the disc; the disc may have fingerprints or smudges. 
Examine the disc for any cracks or scratches that might be interfering with 
playback. Make sure the disc playback is not restricted by parental control 
options.

A. 1. Compact

 2. Bits

 3. RAM

 4. Pen drive

 5. Hard disk

 6. Byte

 7. ROM
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B. Do yourself.

C. Do yourself.

A. Tick ( ) the correct option.

 1. (c) 2. (b) 3. (a) 4. (a) 5. (c)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. F 2. T 3. F 4. T 5. F

C. Fill in the blanks.

 1. File Explorer  2. Start  3. double click

 4. secondary  5. Rename

D. Rewrite the jumbled words correctly.

 1. 

 2. 

Managing Files and Folders in Windows 103
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 3. 

 4. 

 5. 

E.  Answer the following questions.

 1. The most significant difference between a file and folder is that a file is 

collection of related information, while a folder is a container that holds 

related files and other sub-folders.

 2. You can check the file extension from the Type column in Windows file 

explorer.

 3. To change the name of the folder/file follow the given steps :

  Step 1 : Right-click on the desired file/folder.

  Step 2 : Select Rename option from the shortcut menu.

  Step 3 : The name of the folder/file will be highlighted. You can delete 

the name and type a new name.

 4. Step 1 : Place the cursor on the file/folder you want to delete and right 

click on it.

  Step 2 : Select Delete option from the shortcut menu.

     A confirmation message appears on the screen.

  Step 3 : Select Yes option to delete the file/folder. The deleted 

file/folder will be moved to Recycle Bin.

  Shortcut way to delete a file/folder is to drag and drop the file/folder in 

the Recycle Bin.

 5. When you delete a folder, you're also deleting everything inside of it. 

Deleted folders are sent to the Recycle Bin.
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1. (a) Right click on the blank area of the Desktop. A context menu appears.

 (b) Click on New option and it will open a submenu with a lot of items .

 (c) Choose Folder option. A new folder with name “New Folder” will be 
placed on the Desktop.

 Alternatively,

 You can use Ctrl+Shift+N to create a folder.

2. See topic 'Deleting a File/Folder' on Book Page No. 26, 27.

3. To open a file or folder, simply move the mouse pointer to the particular 
file/folder and double-click on it. The file/folder will open and you can view its 
contents.
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A. 

B. Do yourself.

C. Do yourself.
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A. Tick ( ) the correct option.

 1. (b) 2. (a) 3. (a) 4. (a) 5. (a)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. T 2. T 3. F 4. T 5. F

C. Fill in the blanks.

 1. left  2. Italics  3. Toggle

 4. Bullet 5. Line spacing

D. Match the following.

 1. Ctrl + L    (a) Bold

 2. Ctrl + J    (b) Center align

 3. Ctrl + B    (c) Italic

 4. Ctrl + U    (d) Left align

 5. Ctrl + I    (e) Justify

 6. Ctrl + E    (f) Underline

MS Word : Text Formatting4
C H A P T E R
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E.  Answer the following questions.

 1. Thus formatting means changing the text appearance to make it 

attractive, by changing its alignment, style, font, size and font colour.

 2. The Change case button in the Font group of the Home tab gives you five 

options to change the case of the typed text. These are as follows:

  (a) Sentence case : Capitalized the first letter of every sentence.

  (b) lowercase : Each letter of the text appears in the small letters.

  (c) UPPERCASE : Each letter of the text appears in capital letters.

  (d) Capitalize Each Word : The first letter of each word is capitalized.

  (e) tOGGLE cASE : Changes the lowercase characters to uppercase and 

the uppercase characters to lowercase.

 3. Line spacing is the vertical distance between successive lines of the text in a 

document. We can also increase or decrease the line spacing between a 

paragraph.

 4. Alignment is the positioning of text in a document within the margins. In 

MS Word, we can align the text in four different ways – Left, Right, Center 

and Justify. In MS Word By default, the text is left aligned.

 5. Use Format Painter to quickly apply the same formatting, such as color, font 

style and size, or border style, to multiple pieces of text or graphics. With 

Format Painter, you can copy all of the formatting from one object and 

apply it to another one-think of it as copying and pasting for formatting.

 6. Font color is the actual color in which text will appear on your screen. 

Highlighting color is the shade of a color over your text.

1. A numbered list is a point-wise list of items where each item is preceded by a 
number.

 The steps to create numbered list are as follows:

 Step 1 : Select the text to which you want to add Numbers.

 Step 2 :  Click the Home tab.

 Step 3 :  Click on the Numbering button in the Paragraph group.

 Step 4 :  Select the list style of your choice.

2. See topic 'Applying Border and Shading' on book page no. 38.
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A. Font Type

Font Color Align Left

Bold

Italic Underline Text Highlight Color

Font Size Change Case Clear Formatting Bullets Numbering
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C. Do yourself.

A. Tick ( ) the correct option.

 1. (c) 2. (b) 3. (a) 4. (b) 5. (a)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. T 2. T 3. T 4. F 5. F

C. Fill in the blanks.

 1. .pptx  2. F5  3. Slides pane

 4. Ctrl + M  5. Esc

Introduction to PowePoint 20165
C H A P T E R
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D. Rearrange the letters to get correct word.

 1. 

 2. 

 3. 

 4. 

 5. 

E.  Answer the following questions.

 1. A presentation is a structured delivery of information. It is a systematic 
display of information along with graphics movies and sounds. All these 
are displayed together on the screen. So, the file that we make in 
PowerPoint is called a Presentation.

 2. A slide is a single page of a presentation.

 3. Placeholders : These are the dotted boxes seen on the slide. This is where 
you type your text. Placeholders can also contain pictures, charts and 
other non-text items.

 4. To insert a new slide in a presentation, follow the given steps :

  Step 1 : Click on the Home tab. 

  Step 2 : Click on the New Slide button from the Slides group. A list 
appears.

  Step 3 : Choose the option you want to apply. The new slide will be 
added.

  You can also insert a new slide by right clicking in the Slides Pane. Select 
New Slide option from the pop-up menu.

 5. A presentation is made up of several electronic pages called Slides. These 
slides are grouped together in a sequence to form a slide show. A slide 
show is an electronic presentation displayed on a computer screen.

 6. 
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I t  d i s p l a y s  t h e  s l i d e s  o f  y o u r 
presentation as small images. This view 
allows easy navigation through slides.

Slide pane contains the current slide in 
your presentation.

Slide Tab Slide Pane

1. You can enter the text in these placeholders by using the following steps:

 Step 1 : Click anywhere inside the Title placeholder, and type the title of your 

presentation.
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 Step 2 : Click inside the Subtitle placeholder and type out additional 
information about the title.

 Step 3 : Click anywhere outside the placeholder to finish.

2. We need to save the presentation if we want to use it in future. The steps to 
save a presentation are given below:

 Step 1 : Click on the File tab and Click on the Save option.

 Step 2 : Click on the Browse option. The Save As dialog box appears.

 Step 3 : Type the file name in the File name box. 

 Step 4 : Click on the Save button. The presentation will be saved with the 
name 'presentation' having an extension '.pptx'.

A. Tick ( ) the correct option.

 1. (a) 2. (c) 3. (a) 4. (b) 5. (a)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. F 2. T 3. T 4. T 5. F

C. Fill in the blanks.

 1. block palette, script area    2. Looks

 3. Control 4. Stamps  5.  

D. Write the functions of these blocks.

 1. Shows the sprite on the stage.

 2. To create a duplicate copy of the sprite.

 3. This block pauses the running of the script for the number of seconds 
given in the block.

More About Scratch6
C H A P T E R

A. 1. Creating a new presentation   (a) Ctrl + O

 2. Saving a presentation   (b) Ctrl + M

 3. Opening a presentation   (c) Alt + F4

 4. Inserting a new slide   (d) Ctrl + N

 5. Closing PowerPoint   (e) Ctrl + S

B. Do yourself.
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 4. It is used to turn the sprite in the opposite direction as it reaches the edge 
of the stage.

 5. Adds a speech bubble to the sprite for the specified period of time.

E.  Answer the following questions.

 1. Scratch Blocks menu is organized into 10 colour coded categories: 
Motion, Looks, Sound, Pen, Data, Events, Control, Sensing Operators and 
More Blocks.

 2. 

 3. Control Block have looking blocks which are used when the same blocks 
have to be repeated for a number of times.

   and  are two control blocks.00000000 00000000

 4. x = 0  and  y = 0

 5. To draw a coloured line, type the given script.

1. Events blocks tell Scratch when to start running the program by setting a 
triggering moment, such as clicking the green flag.  block activities 000000000
the script when the green flag or Go button is clicked.

2. Do yourself.
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B. Do yourself.
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A. Tick ( ) the correct option.

 1. (a) 2. (b) 3. (b) 4. (b) 5. (c)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. T 2. F 3. T 4. T 5. T

C. Fill in the blanks.

 1. Creative  2. AI  3. IOT

 4. Artificial Intelligence  5. Smart Home

D. Answer in one word.

 1. Chatbot

 2. Amazon, Flipkart, Snapdeal

 3. 'Siri' is used by Apple and 'Google Assistant' is used by Google.

 4. Alexa, Echo, Cortana, Google Assistant

 5. Smartphone

E.  Answer the following questions.

 1. Artificial Intelligence is the ability of a machine to think and learn. 
Artificial intelligence (AI) is an area of computer science that emphasizes 
the creation of intelligent machines that work and reacts like humans. 

  It is the science and engineering of making intelligent machines, 
especially intelligent computer programs. It is related to the similar task 
of using computers to understand human intelligence.

 2. Here are some examples of smart home products and their functions.

  § Cameras will track your home's exterior even if it's pitch-black 
outside.

  § You can control a thermostat from your bed, the airport, anywhere 
your smartphone has a signal.

  § LED lights to let you program colour and brightness right from your 
smartphone.

 3. An Intelligent Personal Assistant (IPA) is software that has been 
designed to assist people with basic tasks, usually providing information 
using the input in the form of natural language.

 4. A Chatbot is a computer program designed to simulate conversation with 
human users, especially over the Internet.

 5. When you begin typing a search term and Google makes 
recommendations for you to choose from, that's Al in action. Predictive 

About Artificial Intelligence7
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searches are based on data that Google collects about you, such as your 
location, age, previous searches and other personal details. Using AI, the 
search engine attempts to guess what you might be trying to find.

1. Disadvantages of AI devices:

 (a) They cannot work outside of what they were programmed for.

 (b) No emotions are present in an AI system.

 (c) Robots can lead to severe unemployment by replacing their jobs.

 (d) Human can become too dependent on AI and lose their mental capacities.

2. No, it is not possible because facebook uses AI to recognize faces.

A. Do yourself.

B. Do yourself.

A. Tick ( ) the correct option.

 1. (c) 2. (a) 3. (b) 4. (b) 5. (a)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. F 2. T 3. T 4. F 5. T

C. Fill in the blanks.

 1. Network  2. URL  3. Website

 4. Refresh  5. Search engine

D. Rearrange the letters to get correct words.

 1. 

 2. 

 3. 

 4. 

 5. 

More About Internet8
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E.  Answer the following questions.

 1. The Internet started as ARPANET. In 1970s, the U.S. Defence department 
established an agency for research and analysis in the field of defence. 
This agency was named as the Advanced Research Projects Agency or 
ARPA. ARPA set up a network of computers between different offices of 
defence department to exchange and share important information. This 
network of computers was called the Advanced Research Projects 
Agency Network or ARPANET.

 2. (a) A website is a collection of web pages containing related information 
related to a certain topic. It is like a book having various chapters on 
different topics. Each website on the internet has a unique name or 
address. Web pages of website are linked with each other.

  (b) The first page of a website, which is displayed by default, is called a 
home page. We get this page when we open a website.

  (c) World Wide Web (WWW) is like a very large library from where we 
can get different types of information in the form of text, picture, 
sound, video, etc. It is an electronic library, available on the Internet. 
It is a series of servers that are interconnected. A lot of information is 
stored on these servers.

  (d) The Internet started as ARPANET. In 1970s, the U.S. Defence 
department established an agency for research and analysis in the 
field of defence. This agency was named as the Advanced Research 
Projects Agency or ARPA. ARPA set up a network of computers 
between different offices of defence department to exchange and 
share important information. This network of computers was called 
the Advanced Research Projects Agency Network or ARPANET.

 3. Getting the data from the host computer (server) to the client computer 
is known as downloading while copying the data from the client 
computer to the host computer is known as uploading.

 4. Each website has a unique address known as Uniform Resource Locator 
(URL). URL represents the full address of any source located on the 
computer. You can quickly display any web page if you know its URL.

  A URL has three parts:

  §  Protocol §  Host Name §  File Name

  For example,

  www.cartoonnetwork.com and www.discoverychannel.com are the 
URLs of Cartoon network and Discovery channel, respectively.

 5. A search engine is a website designed to search for information on the 
World Wide Web. You just enter the keywords and the search engine gets 
you the relevant information. There are many search engines that you 
can choose from like., www.google.com www.yahoo.com and 
www.bing.com.



1. A search engine is a software program that helps people find the information 
they are looking for online using keywords or phrases. Search engines are able 
to return results quickly-even with millions of websites online-by scanning the 
Internet continuously and indexing every page they find.

2. Laptop HP & Dell.
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A. Tick ( ) the correct option.

 1. (c) 2. (b) 3. (c) 4. (c) 5. (b)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. F 2. F 3. F 4. F 5. T

C. Fill in the blanks.

 1. Analytical Engine  2. Charles Babbage

 3. IBM  4. 1832  5. Analytical Engine

D. Expand the following:

 1. International Business Machines

 2. Universal Automatic Computer

 3. Electronic Discrete Variable Automatic Computer

 4. Electronic Numerical Integrator and Calculator

 5. Atanasoft-Berry Computer

E.  Answer the following questions.

 1. Abacus.

 2. Mark 1 was the first digital electronic computer which was invented by 

Howard Aiken.

 3. Desktop computers, laptop computers, palmtop computers and tablets 

are different types of microcomputers.

 4. First Generation computers were very big as that of a room, were not 

reliable, worked slowly, consumed a lot of electricity and generated a lot 

of heat.

 5. Napier's Bones.

Computer History and Development1
C H A P T E R

TECH TOUCH 5

1. Abacus.

2. Artificial Intelligence is shaping the future of humanity across nearly every 

industry. It is already the main driver of emerging technologies like big data, 

robotics, smart homes, driverless car, chatbots and IOT, and it will continue to 

act as a technological innovator for the foreseeable future.
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B. 1. Abacus  2. Pascaline

 3. Transistors  4. Supercomputers

C. Do yourself.

A. Tick ( ) the correct option.

 1. (c) 2. (b) 3. (b) 4. (c) 5. (b)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. T 2. F 3. T 4. T 5. T

C. Fill in the blanks.

 1. Operating system  2. Microsoft Store

 3. Cortana  4. Recycle Bin 5. Start Menu

D. Unscramble the given words:

 1. 

 2. 

 3. 

 4. 

 5. 

E.  Answer the following questions.
 1. § It is easy-to-use, more interactive, and the most secured version of 

Windows.

Understanding Windows 102
C H A P T E R
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  § It is much more personal and provides you with the ability to redecorate 
your desktop with new backgrounds, themes, colours and icons.

 2. The Start menu in Windows 10 is a blend of the old menu, found in 
Windows 7 and Start screen in Windows 8. When you click on the Start 
button at the bottom-left of the screen, you get two panels, side-by-side. 
The left panel displays the pinned, recently added, and most-used apps. 
The right panel displays a section of the live tiles that you can customise, 
resize, and reorganise.

 3. Task View is a task switcher and virtual desktop system introduced in 
Windows 10. Task View allows a user to quickly locate and open window, 
quickly hide all windows and show the desktop, and to manage windows 
across multiple monitors or virtual desktops.

 4. A Universal Windows app is a software application that can run not just 
on a Windows PC, but also on a Windows tablet, smartphone, or 
smartwatch as well. Windows 10 provides a bundle of built-in apps, like 
Photos, Maps, Mail, Alarms, Clock, Calendar, etc. You can find and use 
these apps from the option in the Start menu.

 5. Windows 10 displays the most popular universal apps in the form of 
resizable live tiles in the right pane of the Start menu. These tiles display 
the latest updates and information, such as news, weather report, 
incoming mails, etc., without opening the app. You can rearrange, resize, 
and move these tiles according to your requirement.

  We see Microsoft Edge, Microsoft Store and Weather tiles on our 
computer Start menu.
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A. Tick ( ) the correct option.

 1. (a) 2. (c) 3. (a) 4. (b) 5. (c)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. F 2. T 3. F 4. F 5. T

C. Fill in the blanks.

 1. Shapes  2. Thesaurus 3. red

 4. Resizing, Rotation  5. Home

D. Read the clues and name the following.

 1. Clipart  2. Resizing handles

 3. Drag and drop  4. Rotation handles

E.  Answer the following questions.

 1. See topic 'Pictures' on book page no. 29, 30.

 2. Thesaurus allows us to view synonyms (words with similar meaning) of a 

word.

 3. see topic 'Pictures' on book page no. 29, 30.

 4. To move a picture, bring the pointer over it. When the pointer changes 

shape, to move icons, drag the picture and drop it at a desired location.

 5. Thesaurus is a built-in dictionary that enables you to look up synonyms, 

antonyms, word substitutes and alternate spellings. This feature 

increases your writing abilities and vocabulary and helps you to better 

understand the text.

Graphics in MS Word3
C H A P T E R

1. He should use Online Pictures option by selecting the Pictures option from the 

Illustrations group on the Insert tab.

2. She should use WordArt button in the Text group on the Insert tab.

A. Do yourself.

B. Do yourself.
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A. Tick ( ) the correct option.

 1. (c) 2. (c) 3. (a) 4. (a) 5. (a)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. T 2. F 3. F 4. F 5. T

C. Fill in the blanks.

 1. 1.15 2. Page setup, Layout

 3. Portrait 4. 0.5   5. Paragraph spacing

D. Match the following icons with their names:

 1.      Page Border

 2.      Breaks

 3.      Line and Paragraph Spacing

 4.      Decrease Indent

 5.      Orientation

E.  Answer the following questions.

 1. Header and Footer options are used to place some information on top 

and bottom of every page, respectively. Headers and footers generally 

contain page number, file name, title of the document, the author's 

name, the current date and so on.

 2. Line spacing means the amount of vertical space between the lines of 

text while indentation determines the amount of spacing between the 

text and the page margins.

 3. A page break is that place in a document where one-page ends and the 

next one begins. While typing a document, a page break gets inserted 

automatically when a fixed number of lines have been typed. However, 

many times you need to force a page break to suit your requirement.

  Page breaks move the text to a new page before reaching the end of a page.

 4. Page Orientation is the property to set the printing direction of the text 

on a paper. The two most common types of orientation are portrait and 

landscape.

 5. Line spacing means the amount of vertical space between the lines of 

text while paragraph spacing is the amount of vertical space above or 

below a paragraph.

More Features of MS Word 20164
C H A P T E R
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1. See the topic 'Indentation', 'Setting Margins', 'Paragraph Formatting' of this 
chapter.

2. Page Layout tab and Page Setup group.

A. Do yourself.

B. Do yourself.

A. 1. 

 2. 

 3. 

 4. 

 5.

B. Do yourself.
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A. Tick ( ) the correct option.

 1. (c) 2. (c) 3. (a) 4. (b) 5. (b)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. T 2. F 3. F 4. T

C. Fill in the blanks.

 1. Reading  2. Slide Sorter 

 3. Background  4. Animation

D. Read the clues and name the following.

 1.     (a) Slide Sorter view

 2.     (b) Normal view

 3.     (c) Reading view

 4.     (d) Slide show view

More About PowerPoint 20165
C H A P T E R
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E.  Answer the following questions.

 1. Side layout is the formatting and positioning of the placeholder boxes for 

the content that appears on a slide.

  PowerPoint includes nine in-built slide layouts.

 2. PowerPoint has five presentation views:

  Normal view, Outline view, Slide Sorter view, Notes Page view, Reading 

view.

 3. The animation effects are available in the Animations tab and are divided 

into four categories as given below:

  Entrance: This category has effects that control the entry of an object on 

the slide.

  Emphasis: This category has effects that help to highlight an object 

during the slide show in order to catch the audience attention.

  Exit: These effects define how the object would leave the slide.

  Motion Paths: This effect is like emphasis effect, but the object moves 

within the slide along a path or a pattern, such as a circle or a square.

 4. 

A transition is the special effects 
that occurs when you exit one slide 
and move on to the next during a 
presentation.

An animation is a special effect that 
applies to a single element on a 
slide such as text, a shape, an 
image, and so on.

Slide Transition Slide Animation

1. You can change the background color, pattern and texture of a slide. To change 

the background of a slide, follow the given steps.

 Step 1 : Click on Design tab.

 Step 2 : Select Format Background option in the Customize group.

    A Format Background task pane opens on the right side of the 

window. It has four Fill effects- Solid Fill, Gradient Fill, Picture or 

Texture Fill and Pattern Fill.

 Step 3 : Click on the radio button of the Fill option you want.

2. Slide Sorter View.

3. See topic 'Applying Themes on Slides' on page 54, 55.

53



A. 

B. Do yourself.

Title Slide

Two Content

Blank

Title and Content

Comparison

Content with Caption

Section Header

Title Only

Picture with Caption

A. Tick ( ) the correct option.

 1. (c) 2. (c) 3. (b) 4. (a) 5. (a)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. T 2. T 3. T 4. T 5. T

C. Fill in the blanks.

 1. Rows, Columns  2. Name box

 3. single  4. active  5. Ctrl + S

D. The active cell in a worksheet is B7. Write the location of cells as specified.

 1. B6 2. B8 3. C7 4. A7 5. D7 (right of B7)

Introduction to MS Excel 20166
C H A P T E R
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E.  Answer the following questions.

 1. A spreadsheet is a tool that is used to store, manipulate and analyze data. 

Data in a spreadsheet is organized in a series of rows and columns and can 

be searched, sorted, calculated and used in a variety of charts and graphs.

 2. Rows are the horizontal lines in the worksheet, and columns are the 

vertical lines in the worksheet. A cell is the intersection of a row and a 

column. A cell is identified by an address that consists of the column 

name followed by the row number. For example, the first cell is referred 

to as A1, which indicates that it lies at the intersection of the column A 

and row 1. This is the active cell.

 3. As the name suggest, it is the cell that is currently active or selected. It can 

be recognized by its green outline. Data can be entered only in the active 

cell.

  It you want to rename a workbook, first locate it in Windows Explorer, 

then you can press F2, or right-click and select Rename, then type the 

new name. If your workbook is already open, then you can go to File  

Save As to save the workbook with a different name.

 4. Title Bar, Name Box, View Button, Active Cell.

 5. A worksheet is a spreadsheet with rows and columns where you can type 

and store data, and perform various operations on the data. 

  A worksheet consists of 1,048,576 rows and 16,384 columns.

  To create a new workbook, when the Excel application is already running, 

follow the given steps:

  Step 1 : Click on File tab. A backstage view appears.

  Step 2 : Click on New in the left pane. A new pane appears on the 

backstage view.

  Step 3 : Click on Blank workbook.

1. (a) Click the cell you want to edit.

 (b) Click in the formula bar.

 (c) Make your changes.

 (d) Press Enter.

 The cell is updated with the new text.

2. See topic 'Saving A Workbook' on book page no. 67.
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A. EVS - A1 Computer - C2  Science - G1

 English - E3 Hindi-B5   Maths-D5

 G.K. - G4 SST - F6   Sanskrit - C8

B. Do yourself.

A. Tick ( ) the correct option.

 1. (a) 2. (a) 3. (b) 4. (b) 5. (b)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. T 2. T 3. T 4. T 5. T

C. Fill in the blanks.

 1. Shakey  2. Honda  3. Sophia

 4. ELIZA  5. Google

D. Match the following:

 

E.  Answer the following questions.

 1. Artificial Intelligence is a wide ranging branch of computer science 
concerned with building smart machines capable of performing tasks 
that typically require human intelligence.

 2. Alan Turing was an English mathematician and pioneer in the field of 
cryptology and computer science. His most famous contribution to the 
field of computing was the Universal Turing machine. One of the greatest 
achievements of Alan Turing is the creation of Bombe, a machine that 
could decode, encode messages.

Evolution of AI7
C H A P T E R

WABOT - 1

Kismet

Bombe

Shakey

Roomba

ASIMO

56



 3. NASA's Mars Exploration Mission in 2004 was a robotic space mission 
involving two Mars rovers, Spirit and Opportunity, to explore planet Mars.

 4. Roomba is a series of autonomous robotic vacuum cleaners made by the 
company iRobot. They have a set of sensors that enables them to 
navigate the floor area of a home.

 5. AI winter is a quiet period for artificial intelligence research and 
development. Over the years, funding for AI initiatives has gone through 
a number of active and inactive cycles. The label winter is used to 
describe dormant periods when customer interest in AI declines.

1. Latest AI technology are listed below:

 Natural language generation, Speech recognition, Virtual agents, Decision 
management, Biometrics, Machine learning, Robotics, Deep learning, Self-
driving cars, etc.

2. Projectors, Robotics lab, GPS-tracker, CCTV cameras, Library Management 
System, Graphic Tablets, Stylus, Wireless microphone, Student Response 
System, Educational Software, Printer, etc.

A. 

B. 1. 

 2. 

 3. 

 4. 

 5. 

C. Do yourself.
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A. Tick ( ) the correct option.

 1. (a) 2. (c) 3. (c) 4. (a) 5. (a)

B. Write  for True and  for False statements.‘T’ ‘F’

 1. T 2. T 3. F 4. F 5. F

C. Fill in the blanks.

 1. broadband  2. ISP  3. Website

 4. @   5. attachment

D. Write the full form of following:

 1.  Internet Service Provider

 2. Modulator - Demodulator

 3. Bharat Sanchar Nigam Limited

 4. Mahanagar Telephone Nigam Limited

E. Answer the following questions.

 1. Dial-up requires users to link their phone line to a computer in order to 
access the Internet. It doesn't allow users to make or receive phone calls 
through phone service while using the Internet.

 2. 

Internet and Email8
C H A P T E R

Wireless uses radio frequency to 
connect to the Internet. Wireless 
connections are possible through 
the modem, which picks up 
internet signals and sends them to 
computers.

It allows users to access the 
Internet over a smartphone 
provided offer voice plans with 
Internet access.

Wireless Mobile Internet

 3. E-Mail stands for Electronic Mail. It is a facility on Internet to send and 
receive messages anywhere around the world in real time. Apart from 
textual data, we can send images as well as audio and video files through 
e-mails. These extra files are called attachments.

  Advantages of E-mail

  § E-mail is cost effective and fast.

  § It can reach any part of the world within a few seconds or few minutes.

  § It is a reliable source of communication.

  § Any form of data like text, graphics, sound or video can be sent 
through e-mail.
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 4. See topic 'Writing and Sending and E-mail' on book page no. 88.

1. She should use attachments option to send music file.

2. He should use Bcc (Blind carbon copy) option.
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A. Do yourself.
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